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1 Introduction 
1.1 User goals 
The built-in predefined styles feature of Microsoft Word lets users categorise parts of their document. 
This allows reusability - assigning the same style to different sections, such as titles, headings, 
emphasis. The formatting aspects (e.g., font type, line spacing, indents) of those predefined styles can 
be edited by the user. The user can also create new predefined styles. Additionally, if the “skeleton” 
of the document has been created using predefined heading styles, the table of contents can be 
generated automatically. 

This functionality is especially useful for formatting longer texts with a variety of sections that need 
special reusable styling, such as books or reports. With predefined styles, the user does not need to 
edit the style of each section manually. As a result, the document has a consistent and professional 
appearance. 

Therefore, the main user goals can be formulated as follows: 
- Create documents with a consistent appearance 
- Spend as little time on styling as possible 
- Generate table of contents automatically 

This usability testing session analyses how these user goals are supported by Microsoft Word and its 
predefined styles functionality. 

1.2 Tasks 
To test how well Microsoft Word currently supports the aforementioned user goals, participants are 
asked to complete three tasks (see Appendix 6.5). For context, participants are asked to imagine 
themselves in a scenario where they are writing a usability testing report for their studies. 

The first task is to reformat a digitally provided text to match the formatting and style of a sample 
document as close as possible, and to insert a table of contents. The sample document uses the default 
(most common) predefined styles of Microsoft Word. This task is designed to test participants’ 
knowledge of the existence of the predefined style functionality. 

The second task is to number all the different level headings in the document. If the first task has 
been successful, participants are asked to use the resulting document. Otherwise, they are presented 
with a correctly formatted document without any numbering as a starting point. This task is designed 
to observe whether users add numbering manually, by editing the predefined styles, or by converting 
the headings to lists. 

The third task is focused on creating a custom predefined style based on an existing predefined title 
style. The participants are asked to name the new style, keep the font and font size of the existing 
style, but to change the colour, add an indent and increase the spacing after the paragraph. The 
existing style that the new style is based on needs to remain unchanged. This task detects how easy it 
is to create a new style and edit the attributes of it. 

2 Methods 
Many usability tests use the concurrent think aloud (CTA) protocol. CTA is practiced to analyse user’s 
thought process during them using the system, and to observe their feedback and emotional 
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responses in real time [1]. CTA enables finding usability mistakes and empathising with the users and 
their needs.  

CTA relies on sequentially generated verbal usability data instead of subjective analysis. The test 
administrator should try to avoid interfering with the user’s thought process and let them focus on 
the task at hand to avoid eliciting additional cognitive processes. The prompts used to encourage 
thinking aloud ought to provoke only the short-term memory [2], for example, “mm-hm”, “keep 
talking”, “what are you reading now?” (Level 1) or “what do you see in the picture?”, “was that difficult 
to do?” (Level 2). For Level 3 data (e.g. “which feature did you prefer?”), users need to access their 
long-term memory and re-synthesise the information. As a result, the data is subjective and affected 
by the user’s cognitive processes. 

CTA is used in this usability testing as a method for collecting insights about how users use the 
predefined styles functionality of Microsoft Word. 

3 Results 
Out of the seven testing sessions, 17 different usability problems were identified (see Appendix 0). 
Two of them, which have the most impact and should be solved immediately, have been brought out 
as follows. 

3.1 UP009 Numbering is not added to all headings of the same type 
Breakdown 

The user tries different numbering options from the menu bar, successfully numbering only one 
heading of the same type (with the same predefined style) at a time. After each wrong numbering 
action, the user has to click on the numbering button again to try the next option. None of the options 
explored by the user add the numbering to all targeted headings in the document, so the user gives 
up and resorts to manually numbering all headings instead. 

Design flaw 

Adding a number to one heading using the Word’s numbering functionality does not always 
automatically number all other headings of the same type. All headings are numbered only when the 
correct action is chosen, but the right action is difficult to distinguish from the list of multiple 
numbering options (see Figure 1). No preview is shown when the user hovers the mouse over a 
numbering option, so the outcome of the action is unknown before choosing it. 
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Figure 1. Regular numbering options (left) and list numbering options that can be used to number all headings of the same 
type at the same time (right). 

Outcome 

It is difficult to discover the correct action on one’s own. Therefore, the users are likely resistant to 
learning unless they find the correct action accidentally. 

Before the user has learned to handle the problem, it will occur every time headings need to be 
numbered. Potential users include everyone who write structured texts. 

Numbering the headings manually costs time. In addition, manually numbered headings are difficult 
to edit afterwards, slowing down the workflow, making the document inconsistent and numbering 
errors hard to notice. Furthermore, user is frustrated with the system’s behaviour and their inability 
to make the system behave the way they want it to. User can feel as if they lack in skills. Overall, 
effectiveness, efficiency, and satisfaction are affected negatively. 
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3.2 UP007 Mismatch between the mental and conceptual model for inserting table 
of contents 

Breakdown 

The user wants to add a table of contents to the document. 
The user looks in the “Insert”-menu first. They say: “Since I 
want to insert it, it must be in this menu.” After not finding 
it there, the user browses through the menus until finding 
the option in the “References” menu tab. “I did not expect 
to find it here,” they say. 

In another case, the user does not notice the option in the 
references tab either and uses the “Help”-functionality to 
search for table of contents. They are presented with a list 
of items, the first of which guides them to the “References”-
tab and tells how to insert the table of contents there (see 
Figure 2). 

Design flaw 

The problem is caused by the mismatch between the user’s mental model and the system’s conceptual 
model. Since users themselves refer to the operation as inserting a table of contents, their instinct 
tells them to search for it in the “Insert”-menu. However, in Word, this option is found in the 
“References”-menu (see Figure 3). 

 

Figure 3. "Insert"- and "Reference"-menus. 

Outcome 

Users will learn to deal with this problem depending on how often they use this functionality. Less 
frequent use causes the user to forget about the system’s conceptual model. 

It is expected that this problem will occur almost every time a user wants to add a table of contents 
to the document, especially when not done regularly. Many users, such as students and book authors, 
may encounter this problem. 

Searching for the place to insert the table of contents costs time and slows down the workflow which 
reduces effectiveness. Not finding the functionality in an expected place causes frustration. 

4 Discussion 
4.1 Conclusion 
Microsoft Word provides many opportunities to work on documents more effectively and efficiently. 
Predefined styles support consistent formatting, reusability and faster work processes. However, 
often the cornucopia of functionality remains unused due to being difficult to find (hidden in many 

Figure 2. Searching for table of contents via the help 
functionality. 
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submenus, behind non-descriptive icons) or due to the user simply not knowing this functionality 
exists. 

There are some mismatches between the user’s mental model and the system’s conceptual model, 
some inconsistencies between Word, other text editors, and common mouse actions. When users are 
unable to find the action they are looking for, they often opt for formatting the document manually 
instead. This costs time, causes frustration and mistakes. Manually formatted document is 
inconsistent and more difficult to edit afterwards. Some functionality, such as table of contents, 
cannot be used when headings have been formatted manually. 

Overall, Microsoft Word supports its users by providing a large variety of editing options. However, 
how these options are presented and how the users are made aware of the existence of the 
functionality, can be improved to further increase efficiency, effectiveness, and satisfaction with this 
word processor. 

4.2 Reflection 
4.2.1 Test administrator 
Being the test administrator, the most difficult part for me was to know how much I am allowed to 
help the participant. I did not want to risk ruining the data by telling the participant what to do or how, 
but on the other hand I felt highly uncomfortable watching the participant struggle with the tasks. 
They were constantly asking for validation and avoiding direct feedback was challenging. Instead, I 
opted for fillers, such as “mhmh” or “okay”. I tried to wait before giving additional hints. Often, seeing 
the participant struggle also gave feedback on the usability of the system being tested.  

Although I tried to elicit only the first and second level CTA, according to the supervisors some mishaps 
occurred (e.g., “Why do you think that?”, “Why are you grunting?”). 

The context or background story of the tasks could have been communicated more clearly, so as to 
help the participant more. The phrasing of the tasks could have been simpler or more elaborate. I was 
unsure about whether I should explain the task out loud orally or let the participant read it, so I tried 
it both ways. Often, the participant had additional questions anyway. 

On the other hand, I think I did well with the introduction. I made some small talk to calm the 
participant down, let the participant know that they can stop the test any time they want, and assured 
that we are testing the system, not the user. I also tested how the participant manages with the CTA 
by giving them an additional introductory task before starting the actual testing session. At the end, I 
thanked the participant for being a great help. 

I would have liked to find out more about the participant’s opinion on the system by asking them 
questions after the CTA session, but due to limited amount of time that was cut short. 

Overall, I think I managed well in this session, but I definitely need to practice if I want to conduct 
more usability tests in the future. 

4.2.2 Participant 
I am undeniably a participant who talks too much. Using the CTA comes naturally to me, although 
sometimes I start proposing possible fixes or alternatives to the usability problems I find. I was not 
aware that talking too much was a problem before reading [3]. 

On the other hand, there was an incident where the test administrator tried to stop the session 
midway, but I wanted to continue. I had found a way to solve the task and the test administrator 
counted it as correct, although there was an even better, more correct option available that I found 
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immediately after refusing to stop my exploratory events in the system. I suppose, it was partly 
because subconsciously I was testing myself and my ability to complete the tasks the correct way. 

The presence of the observers in the room was difficult, if not impossible, to ignore, but I do not think 
they influenced my behaviour to great extent. Not once did I feel that it is me being tested, not the 
system. 

5 References 
[1] J. R. Bergstrom, “Moderating Usability Tests,” 02-Apr-2013. [Online]. Available: 

https://www.usability.gov/get-involved/blog/2013/04/moderating-usability-tests.html. 
[Accessed: 21-Feb-2019]. 

[2] K. A. Ericsson and H. A. Simon, Protocol analysis: Verbal reports as data. Cambridge, MA, US: 
The MIT Press, 1984. 

[3] T. Boren and J. Ramey, “Thinking aloud: reconciling theory and practice,” IEEE Trans. Prof. 
Commun., vol. 43, no. 3, pp. 261–278, 2000. 
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6 Appendices 
6.1 Incidents 
Following is a list of various incidents observed from the usability testing session per participant. 

 
Participant 1:	

1-1 When user selected one of the styles, the style of the entire document was changed, causes the 
user to think that they have picked the wrong option. (User intended to change the headings only)	

1-2 User looks for adding a new style option under the editing tab next to the styling tab	

1-3 User looks for the numbering option in the insert tab or view tab.	

1-4 Confused about the functionality and hard to return to the previous action.	

1-5 Right clicks on the white space in styles trying to find a NEW option to create a new style.	

1-6 Right clicks one of the style options but does not know how to continue.	

1-7 Chooses manual formatting over using the predefined styles functionality	

1-8 They try alternative way, use right clicks to adjust the font size and colour not using the 
predefined style type.	

1-9 The user knows a certain function is supposed to be used but can’t find the button.	

1-10 The user accidentally unpins the ribbon	

1-11 The user goes to “design”-menu instead of “styles”-section to look for predefined styles	

	

Participant 2:	

2-1 User changes the font size and types manually instead of using the predefined styles from the 
style ribbon 	

2-2 User adds numbers to headings manually, types it number by number	

2-3 Look for the button to insert a table of contents in multiple tabs 	

2-4 User tries to find the properties of adding a new style, but it takes a long time	

2-5 Could not find the option to change font colour when modifying the styles in the window pop-up 
(due to the box saying “automatic” instead of showing colours)	

2-6 Clicks and undoes multiple icons in order to find the automatic header numbering	

2-7 Clicks on the automatic numbering button, but a number is added to currently selected header 
only, not every header with the same style in the document -> opts for manual numbering instead	

2-8 Spends some time looking for indent and spacing adaptation in custom style making	

2-9 On a Mac the toolbars are on the right, so he looks to the right to find the toolbars	
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Participant 3:	

3-1 She deleted too much spaces between Conclusion (Heading 2) and accidentally merged its 
formatting to Discussion (Heading 1)	

3-2 Not sure where to go to insert table of contents. Clicked on “insert” menu, but didn't see 
anything about table of contents	

3-3 Surprised because table of contents was entered in the middle of the text -> erases the table of 
contents, goes to beginning of document and re-enters the table of contents	

3-4 Attempts to number headers manually, because she is not sure if it is possible to do it 
automatically	

3-5 User numbers the headings manually, expects the numbers to appear in the table of contents, 
but the table of content remains unchanged (without numbers in front of headings)	

3-6 Tries to add numbering 4.1 in front of the heading „Conclusion“, but Word automatically added a 
wrong number -> has to undo several times	

3-7 Word changes font size, indentation automatically → frustrated	

3-8 Finds a function for numbering but it only works for one title	

3-9 Didn't know it was possible to make a custom style	

3-10 In modify style popup: Looking for where to change the colour of title style, something like a 
paint bucket icon. Clicks on a label that says “Automatic” although they do not think that one is for 
colour, and is surprised when they find out it was a correct choice.	

3-11 She explored existing Style type to find any similar Style with sample (about spacing)	

3-12 not sure how to add indent/spacing. there is an option „no spacing“, but nothing to change the 
indent	

	

Participant 4:	

4-1 User picked wrong numbering options and she undid that	

4-2 User can’t find the table of contents button in ‘insert’ tab	

	

Participant 5	

5-1 User wants to change the text color, and does it manually and not by changing the style, 
although she has used it before	

5-2 User is not aware of an automatic numbering functionality, and starts to do it manually right 
away	

5-3 Numbers all headings manually	

5-4 Changes text colour via modify style -> format -> text effects -> text fill -> popup for font style	

5-5 Selects the whole heading before applying a predefined style (instead of having a cursor present 
on the line)	
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5-6 Looks for the table of contents in the “insert”-menu, but does not find it there. Uses “help” to 
find how to insert the table of contents instead.	

5-7 Cannot find the appropriate numbering option in the style modifying panel	

	

Participant 6	

6-1 User tapped on the incorrect option to number automatically, then never tapped on the 
automatic numbering function again.	

6-2 First goes to “insert” tab to add table of contents, but it is not there	

6-3 Cannot find an option to add numbers automatically. Tried to edit the styles and then to add 
them manually, but the latter created problems with indentation	

6-4 Adjusts line spacing of the paragraph instead of adding a spacing after the paragraph	

	

Participant 7 	

7-1 Decides to number paragraphs manually (instructions were too vague?)	

7-2 Does not know where to find table of contents. Tries to find it using the Help tab, doesn’t work, 
so tries to find it in Insert tab. Ends up using Help search field to find it	

7-3 Selects the whole heading before applying a predefined style (instead of having a cursor present 
on the line)	
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6.2 Usability problem descriptions 
Usability problems are identified based on incidents encountered in individual testing sessions (see 
Appendix 6.1). 

Problem 1 Terminology for different buttons/menus/items 
carrying different actions is not clearly distinct 

Incidents 

Cause 
(design issue) 

Terminology for different buttons/menus/items doing 
different actions is not clearly distinct; 
Confusing naming/labelling 

1-11 

Breakdown 
(observed interaction) 

The user is unable to distinguish between different naming in 
the menus and on the ribbon (Design vs Style), and, as a result, 
selects the wrong functionality 

Outcomes 
(expected loss, impact of 
problem) 

Time loss trying to find the right functionality; 
Achieving user goals requires more effort; 
Low consistency of style in document (document items are 
styled differently from each other) = unprofessional and 
undesired look for the document; 
The user is unsatisfied and frustrated with the system 

Design change 
(how can the problem be 
solved) 

Clearer terminology for different actions/items; 
Reduced number of items in menus = fewer options to choose 
from 

	
 

Problem 2 Visual separation between sections (styles and 
editing) is not clear enough 

Incidents 

Cause 
(design issue) 

Sections for different tool groupings on the tools ribbon are too 
close to each other (Styles and Editing). 
Separation line exists but is hard to notice (see Figure 4). 

1-2 

1-3 

Breakdown 
(observed interaction) 

Lack of a strongly noticeable visual barrier between the Styles 
and Editing sections of the ribbon makes the user consider 
those sections as one. Attention is directed to both of the 
sections, doubling the search space and making it harder to find 
the functionality they are looking for.  

Outcomes 
(expected loss, impact 
of problem) 

Time loss trying to find the right functionality from a bigger 
search space; 
The user is confused and frustrated; 
Inability to find the right functionality 
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Design change 
(how can the problem 
be solved) 

Emphasize the barrier between each section more; 
Increase the distance between sections; 
Reduce the choices (and sections) in the ribbon 

 

 
Figure 4. Separation line between Styles and Editing sections. 

	
 

Problem 3 Inconsistency in styling prerequisites Incidents 

Cause 
(design issue) 

Inconsistency in prerequisites for using the styling functionality 
between individual styling options and predefined styling.  
For individual styling (e.g. want to make one word in paragraph 
bold) the user needs to select the part of the text they wish to 
edit (e.g. one word) before applying the wanted style (e.g. 
bold). 
For predefined styling, the style can also be applied without 
selecting the section (e.g. heading or paragraph), but just 
having the typing cursor located in the section the user wishes 
to apply the style to. 

5-5 

7-3 

Breakdown 
(observed interaction) 

User unnecessarily selects the whole section (paragraph) of 
text before applying a predefined style to convert it to a 
heading. 

Outcomes 
(expected loss, impact of 
problem) 

Unnecessary additional action costs time 

Design change 
(how can the problem be 
solved) 

Applying individual styling to the whole paragraph when the 
cursor is in that paragraph 
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Problem 4 Icons do not capture the functionality behind 
the button well 

Incidents 

Cause 
(design issue) 

Non-descriptive icons that do not explain the functionality of 
the button well enough. 
Meaning and impact of the functionality of buttons with icons 
(only) is not clear at the first glance. 

1-9 

2-6 

Breakdown 
(observed interaction) 

User exploratively clicks on different buttons invoking an 
action. If the action is not what they are looking for, they undo 
it and try another button until they find the action they were 
looking for. 

Outcomes 
(expected loss, impact of 
problem) 

Looking for the right button costs time; 
Loss in efficiency 
Frustration 

Design change 
(how can the problem 
be solved) 

Add descriptive text to the button; 
Change icons so that they would explain the action better 

	
 

Problem 5 Inconsistency among right-click actions across 
applications and operation systems 

Incidents 

Cause 
(design issue) 

No “Add new style” option appears when right-clicking on the 
Styles section (see Figure 5). 
Often, right-click presents users with an option to add a new 
folder/file, but in MS Word’s Styles section it does not. 

1-5 

1-6 

Breakdown 
(observed interaction) 

The user expects to be able to add a new style by right-clicking 
on an empty space in the section for styles. The user is 
surprised and frustrated when not finding the option in the 
pop-up menu. 

Outcomes 
(expected loss, impact of 
problem) 

Time loss trying to find the right place to add a new style; 
Confusion caused by counterintuitive result to user action  

Design change 
(how can the problem 
be solved) 

Add “New style” option to the pop-up menu that appears when 
right-clicking 
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Figure 5. Right-click on the Styles panel. 

 
 

Problem 6 Unawareness of functionality existence Incidents 

Cause 
(design issue) 

System does not let the user know everything it enables the 
user to do well enough; 
User’s unawareness of functionality existence 

1-7 

1-8 

2-1 

2-2 

3-4 

3-9 

5-1 

5-2 

5-3 

7-1 

Breakdown 
(observed interaction) 

The user is asked to carry out a task that could be done easily 
using some of the built-in functionality of the system. However, 
the user opts to doing the task manually because they do not 
know the functionality exists. 

Outcomes 
(expected loss, impact of 
problem) 

Doing the task manually costs time; 
Inconsistent styling of the document leaves an unprofessional 
look; 
Additional follow-up changes to the document also need to be 
done manually (often, one change affects the following parts 
of the document) 

Design change 
(how can the problem 
be solved) 

Tutorial presented when a document is opened; 
Help functionality where the user types what they want to 
achieve after which the program points them to the right 
functionality or completes the action on its own 

	
 

Problem 7 Mismatch between the mental and conceptual 
model for inserting table of contents 

Incidents 

Cause 
(design issue) 

There is no option to insert a table of contents to the document 
in the “Insert” menu tab; 
System’s conceptual model does not match the user’s mental 
model 

2-3 

3-2 

4-2 

5-6 

6-2 

7-2 

Breakdown 
(observed interaction) 

User wants to add a table of contents to the document and 
looks for it in the “Insert” menu first. After not finding it there, 
the user browses through menus until finding the option in the 
“References” menu tab or uses the “Help”-functionality to find 
it. 
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Outcomes 
(expected loss, impact 
of problem) 

Searching for the location of the insertion action costs time; 
Disappointment and frustration for the user (“It should be 
here!”) 

Design change 
(how can the problem 
be solved) 

Add “Insert a table of contents” action to the “Insert” menu 

	
 

Problem 8 Non-descriptive labelling and icons for colour 
change functionality in “Modify style” window 

Incidents 

Cause 
(design issue) 

Finding where to change font colour in “Modify (predefined) 
style” window is difficult. 
If no specific colour is selected, the pop-up window shows a 
dropdown box with only a label “automatic” instead of a colour 
or an icon indicating the possibility of changing colour (see 
Figure 6). 

2-5 

3-10 

5-4 

Breakdown 
(observed interaction) 

The user opens the “modify (predefined) style” pop-up window 
and looks for a place to change font colour. The user is looking 
for an icon representing a paint bucket which is often used to 
indicate colouring options. There is no such icon present, so the 
user exploratively clicks on different buttons the actions of 
which they do not know. Clicking on a dropdown box with the 
word “automatic” written in it opens a colour palette much to 
the user’s surprise. The user chooses a font colour from the 
palette.  

Outcomes 
(expected loss, impact 
of problem) 

Looking for the place where font colour can be changed costs 
time; 
User gives up on trying to change the font colour; 
Inconsistent styling of the document 

Design change 
(how can the problem 
be solved) 

Add a descriptive label (“font colour”) or a paint bucket icon to 
the dropdown box; 
Show current font colour instead of a label “automatic” in the 
dropdown box 
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Figure 6. Modify Style pop-up window. 

	
 

Problem 9 Numbering is not added to all headings of the 
same type 

Incidents 

Cause 
(design issue) 

Adding a number to one heading does not always automatically 
number all other headings of the same type. 
All headings are numbered only when the correct action is 
chosen, but the right action is difficult to distinguish from the list 
of multiple numbering options. 
No preview is shown when the user hovers the mouse over a 
numbering option, so the outcome of the action is unknown 
unless chosen. 

2-7 

3-8 

4-1 

5-7 

6-1 

6-3 Breakdown 
(observed interaction) 

The user tries different numbering options from the menu bar, 
successfully numbering only one heading at a time. 
After each wrong numbering action, user has to click on the 
numbering button again to select the next option. 
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None of the options explored by the user add the numbering to 
all headings of the same type in the document, so the user gives 
up and resorts to manually numbering all headings instead. 

Outcomes 
(expected loss, impact 
of problem) 

Manual numbering costs time 
User is frustrated with the system’s behaviour and their inability 
to make the system behave the way they want it to; 
User feels as if they lack in skills 

Design change 
(how can the problem 
be solved) 

Automatically add numbering to all headings of the same type; 
Visualise the result of the button click when hovering over the 
button (to reduce the button clicks caused by selecting the 
wrong option)  

 
 

Problem 10 Inconsistency between different word processing 
applications 

Incidents 

Cause 
(design issue) 

Different word processing applications have different layouts 2-9 

Breakdown 
(observed interaction) 

The user is used to macOS’s Pages application where the 
functionality bar (ribbon) is located at the right side of the 
application. In MS Word, the user starts looking for the 
functionalities from the right before realising that MS Word has 
a different location for the functionality ribbon. 

Outcomes 
(expected loss, impact 
of problem) 

(Re-)learning curve repeated again when switching the 
programs 

Design change 
(how can the problem 
be solved) 

Enable customizing the system layout - moving menu bars and 
ribbons around on the screen; 
Move the ribbon to the right 

	
 

Problem 11 Unwanted merge of paragraph styles Incidents 

Cause 
(design issue) 

Removing the line (paragraph) break between paragraphs 
causes the following paragraph to adopt the predefined style 
and formatting options of the previous paragraph 

3-1 
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Breakdown 
(observed  interaction) 

The user has two distinct paragraphs with different styling. 
When removing unnecessary line breaks, they accidentally 
delete the line break between the two paragraphs. As a result, 
the second paragraph adopts the same styling features as the 
first. The user undoes the action to keep the different styling. 

Outcomes 
(expected loss, impact 
of problem) 

Undoing the merge costs time; 
Reapplying the style manually costs time 

Design change 
(how can the problem 
be solved) 

Keep the original formatting of different paragraphs when 
merged together 

	
 

Problem 12 Table of contents is inserted in the middle of the 
document 

Incidents 

Cause 
(design issue) 

Table of contents is inserted wherever the cursor is currently 
located (e.g. in the middle of a text paragraph), as opposed to 
inserting it at the beginning or at the end of the document 

3-3 

Breakdown 
(observed interaction) 

The user wants to insert a table of contents and chooses the 
appropriate action from the menu. The table of contents is 
inserted in the middle of the document where the cursor was 
located. The user is surprised, erases the table of contents, 
moves the cursor to the beginning of the document, and repeats 
the sequence of actions needed to insert the table of contents. 

Outcomes 
(expected loss, impact 
of problem) 

Removing and re-inserting the table of contents costs time 

Design change 
(how can the problem 
be solved) 

Ask the user where to insert the table of contents; 
(Insert the table of contents to the beginning of document 
automatically) 

	
 

Problem 13 Lack of the automatic update of the table of 
contents 

Incidents 

Cause 
(design issue) 

Table of contents does not update automatically when changes 
are made in the document (especially headings that are shown 
in the table of contents) 

3-5 
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Breakdown 
(observed interaction) 

The user adds numbering to the headings in the document and 
expects the numbers to appear in front of the headings in the 
table of contents as well, but the table of content remains 
unchanged (no numbering added in front of the headings). The 
user has to update the table of contents manually by clicking on 
a button. 

Outcomes 
(expected loss, impact 
of problem) 

Inconsistent styling if the user forgets to update the table of 
contents manually; 
Updating the table of contents manually costs time 

Design change 
(how can the problem 
be solved) 

Automatically updating the table of contents when a change 
occurs in the items that are shown in the table of contents; 
Reminding the user to update the table of contents manually 
before document is closed 

 
 

Problem 14 Unpinning the ribbon accidentally Incidents 

Cause 
(design issue) 

Cluttered interface, too many options -> it is easy to 
accidentally click on the wrong button 1-10 

Breakdown 
(observed interaction) 

The user accidentally clicks a button that unpins the ribbon 
located at top of the window, gets confused, and does not know 
how to undo the action and get the ribbon back. Not having the 
ribbon visible does not let the user use most of the advanced, 
more specific functionality. 

Outcomes 
(expected loss, impact 
of problem) 

Dealing with getting the menus back costs time; 
Frustration because of unintended action and unexpected 
reaction in the system 

Design change 
(how can the problem 
be solved) 

Reduce the functionality options that are displayed at once; 
Make the buttons bigger and more easily distinguishable;  

	
 

Problem 15 Indent is added automatically when an item is 
numbered 

Incidents 

Cause 
(design issue) 

Indentation is added automatically to the left when an item is 
numbered (converted to a list) 6-3 



 22 

Breakdown 
(observed interaction) 

User successfully adds numbering to a heading, but as a result 
the heading is converted into a list item and indent is added to 
the left. User does not know how to get rid of the indent 
without losing the numbering. 

Outcomes 
(expected loss, impact of 
problem) 

User is negatively surprised and confused by automatic 
indentation; 
User is frustrated when they do not know how to get rid of the 
added indent; 
Trying to lose the indent takes time 

Design change 
(how can the problem 
be solved) 

Do not add automatic indent when a numbering is added; 
Keep the numbered text on the same level as it was before 
numbering 

	
 

Problem 16 Not finding properties of a new style  Incidents 

Cause 
(design issue) 

In the style properties pop-up, the different options to modify 
a style are not labelled clearly. Users can choose different 
aspects of the style they want to change in a drop-down menu 
on the bottom left, which is not a place where users typically 
look for these menus. 

2-4 

2-8 

3-11 

3-12 

6-4 

Breakdown 
(observed interaction) 

When customising a style, user spends a lot of time searching 
for the property they want to change. They are not able to find 
certain properties, such as the indent and spacing of a 
paragraph in the style, and/or accidentally choose the wrong 
option. 

Outcomes 
(expected loss, impact 
of problem) 

Searching for the correct place to change a property costs time. 
User is confused and frustrated when they do not find the 
property they want to change. 
User is discouraged from creating their own styles, taking away 
a potentially useful functionality.  

Design change 
(how can the problem 
be solved) 

Move the drop-down menu to the top left/below the four main 
properties. 

	
 

Problem 17 Mistakenly adding a heading to the wrong 
hierarchy automatically 

Incidents 

Cause 
(design issue) 

When there is more than one numbering hierarchy in the 
document and the user adds a numbering to another line, it is 
automatically attributed to the most recent one, which may or 
may not be correct. This happens especially if the hierarchies 
are nested. 

3-6 

3-7 
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Breakdown 
(observed interaction) 

User wants to add numbering to a line, but Word assigns it to 
the wrong hierarchy and changes the indentation and font size 
accordingly. User undoes and redoes the numbering several 
times. If they do not manage to get the desired numbering 
automatically, they do it manually instead.  

Outcomes 
(expected loss, impact 
of problem) 

User becomes frustrated if the expected action does not 
happen.  
Giving up on automatic numbering and doing it manually 
instead takes more time and is less effective in case user wants 
to add a table of contents. 

Design change 
(how can the problem 
be solved) 

Recognise when multiple hierarchies are nested within one 
another. If a new item with numbering is added, users can 
control which hierarchy it belongs to with indentation: if they 
indent a line further, it moves to the next inner list. 
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6.3 Discovery matrix 
The discovery matrix sums up the results from the usability testing. 

The rows (UP) show the usability problems the participants encountered during the testing session. 

The columns P01-P07 correspond to participants who joined the testing session. 

A number in a crossover between a specific problem row and a specific user column indicates that this 
user encountered the corresponding problem in their testing session. The number ([1, 2, 3]) in that 
crossover cell shows how many times the problem occurred for the user in one testing session. 

 P01 P02 P03 P04 P05 P06 P07 
Nr of participants who 

encountered the 
usability problem 

(Problem margin sum) 

Nr of times the 
usability problem 
was encountered 

UP001 1       1 1 

UP002 2       1 2 

UP003     1  1 2 2 

UP004 1 1      2 2 

UP005 2       1 2 

UP006 2 2 2  3  1 5 10 

UP007  1 1 1 1 1 1 6 6 

UP008  1 1  1   3 3 

UP009  1 1 1 1 2  5 6 

UP010  1      1 1 

UP011   1     1 1 

UP012   1     1 1 

UP013   1     1 1 

UP014 1       1 1 

UP015      1  1 1 

UP016  2 2   1  3 5 

UP017   2     1 2 
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6.4 Histogram 
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6.5 Task instructions 
Task 1 

• Reformat the provided text to match the formatting of the printed sample document 

• Don’t forget the table of contents 

Task 2 

• Number the headings and subheadings (e.g. 1 / 1.1 / 1.2) 

Task 3 

The goal of the third task is creating a custom style. 

• Create a new Title style, named NewTitle. The font and font size shouldn’t be changed, but 
change the color, add an indent and a spacing after the paragraph of your choice. The existing 
title style needs to remain unchanged. 
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6.6 Task 1 – Non-formatted text 
Usability Testing Report 

Creating reports with styles | Writing reports with reference | Mastering master slides 

Author 

Student ID 

Introduction 

User goals 

describe the user goals in terms of effectiveness and efficiency 

Tasks 

describes typical tasks and justify your choice of task 

Methods 

Describe the CTA protocol and justify it. Give examples. 

Results 

Choose two usability problems that in your opinion have the most impact and should be taken care of 
as quick and effective as possible (impact of a problem entails thRee cRiteRia, see below). 

Describe each problem in terms of  

Breakdowns (evidence, incidences): describe one or two typical incidence (“The user tried to … but 
what happened was … and the he said: …”) 

Design flaw: what causes the breakdowns and how? 

Outcome by the following criteria (𝑅"): 

Resistance to learning: will users learn to deal with this problem immediately, sooner or later or never. 

Rate of occurrence: how often do you expect this problem to occur for a single user? How many 
potential users are out there?  

Risks: how costly can a single outcome be? In what ways are efficiency and effectiveness lowered? Are 
errors easy to spot and to correct? Does it delay the user significantly? How frustrating is it? Do errors 
cost real money? Are lives in danger? 

Discussion 

Conclusion 

Describe in general terms to what degree user goals (effectiveness and efficiency) are currently 
supported.  

Reflection 

Reflect on you being the test administrator. Was there anything difficult it about it? What were 
supervisors saying? Some remarkable anecdotes? 

Reflect on you being a test person. 

Appendix 

Usability problem descriptions 
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as produced during the workshop 

Discovery matrix 

as produced during the workshop 

Histogram 

Frequency distribution of problem margin sum (this is not a bar chart) 
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6.7 Task 2 – Formatted text with numbered headings 

Usability Testing Report 
Creating reports with styles | Writing reports with reference | Mastering master slides 

Author 

Student ID 

 

7 Introduction 
7.1 User goals 
describe the user goals in terms of effectiveness and efficiency 

7.2 Tasks 
describes typical tasks and justify your choice of task 

8 Methods 
Describe the CTA protocol and justify it. Give examples. 

9 Results 
Choose two usability problems that in your opinion have the most impact and should be taken care of 
as quick and effective as possible (impact of a problem entails thRee cRiteRia, see below). 

Describe each problem in terms of  

1. Breakdowns (evidence, incidences): describe one or two typical incidence (“The user tried to 
… but what happened was … and the he said: …”) 



 30 

2. Design flaw: what causes the breakdowns and how? 
3. Outcome by the following criteria (𝑅"): 

a. Resistance to learning: will users learn to deal with this problem immediately, 
sooner or later or never. 

b. Rate of occurrence: how often do you expect this problem to occur for a single user? 
How many potential users are out there?  

c. Risks: how costly can a single outcome be? In what ways are efficiency and 
effectiveness lowered? Are errors easy to spot and to correct? Does it delay the user 
significantly? How frustrating is it? Do errors cost real money? Are lives in danger? 

10 Discussion 
10.1 Conclusion 
Describe in general terms to what degree user goals (effectiveness and efficiency) are currently 
supported.  

10.2 Reflection 
- Reflect on you being the test administrator. Was there anything difficult it about it? What were 

supervisors saying? Some remarkable anecdotes? 
- Reflect on you being a test person. 

11 Appendix 
11.1 Usability problem descriptions 
as produced during the workshop 

11.2 Discovery matrix 
as produced during the workshop 

11.3 Histogram 
Frequency distribution of problem margin sum (this is not a bar chart) 

 


